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Signing in to Positive Pay

Signing in to Positive Pay

You can log in to the Positive Pay system via Business Online Banking.

1.

2
3
4.
5

Log into Business Online Banking

Hover over Transfer & Pay

Select Positive Pay ACH Alert

Click on Submit

You will be directed to your Positive Pay Dashboard.

(® Gate City Bank

For a Better Way of Life.®

Dashboard

2 Manage Users

i Reports -

ACH Credit Review

End of Day Cut-Off Time: Wednesday 12:00 PM CDT

Total ACH Credits $0.00 o
Set to Pay $0.00 (0] Set to Return $0.00 (0]
Approved List Exceptions $0.00 ©  Block List Returns $0.00 (0]

ACH Incoming Debits

End of Day Cut-Off Time: Wednesday 12:00 PM CDT

Total ACH Debits $0.00 o
Set to Pay $0.00 [0] Set to Return 50.00 (0]
Approved List Exceptions $0.00 ©  Block List Returns $0.00 (0]

Check Positive Pay

End of Day Cut-Off Time: Wednesday 3:00 PM CDT
Exceptions $0.00 [0]

Set to Pay $0.00 o Set to Return $0.00 0

Change Module -




Using the Dashboard

Using the Dashboard

The dashboard is the default landing page within the Positive Pay portal. Summary information on check
transactions and ACH transaction statuses will be displayed for accounts the user has been granted access. Active
links are embedded within the Check Positive Pay, ACH Incoming Debits, and ACH Credit Review boxes to permit
users to navigate from the dashboard landing page into each service module or directly to transactions in the
status selected. Dashboard totals are updated in real time as transaction status values are changed by a user.

The content displayed in the summary boxes includes the following:

(® Gate City Bank

For a Better Way of Life.”

Dashboard 4 Manage Users i Reports - i= Transaction View

ACH Credit Review

End of Day Cut-Off Time: Thursday cDT
Total ACH Credits $0.00 ©  Pending Approval $0.00 (o]
Setto Pay $0.00 [o0] Set to Return $0.00 [0]
Approved List Exceptions $0.00 ©  BlockList Returns $0.00 (0]

ACH Incoming Debits

End of Day Cut-Off Time: Thursday cDT
Total ACH Debits $0.00 ©  Pending Approval $0.00 (0]
Setto Pay $0.00 [0] Set to Return $0.00 [0]
Approved List Exceptions $0.00 @  Block List Returns $0.00 Q

Check Positive Pay

End of Day Cut-Off Time: Thursday CcoT
Exceptions $0.00 Q
Set to Pay 50.00 @  settoRetwrn 50.00 Q

e Service Name - In the example provided, clicking Check Positive Pay on the left in the title bar will direct
the user to the main menu.

o End of Day Cut-Off Time - Displayed in the second bar, the time of day indicates when transactions that
require decisions will no longer be eligible for user decisions. Gate City Bank’s cutoff time is 12:00 p.m.
CST. If a decision is not made by cutoff time, the default decision will process.

e Exceptions - Clicking on the dollar amount hyperlink on the Exceptions line will direct the user to a filtered
view of Transaction History that will display only exceptions that require a decision.

e Total ACH Debits/Total ACH Credits - This total represents the total dollar amount and humber of
incoming ACH debit transactions or ACH credit transactions received by Gate City Bank for the accounts
the user has access to view.

e Approved List Exceptions - This represents the total dollar amount and number of incoming ACH credit or
debit transactions received from companies not on the client’s approved list or have violated an approved
list parameter.

N



Using the Dashboard

o Block List Returns - This represents the total dollar amount and number of incoming ACH credit or debit
transactions received from companies on the client’s blocked list and will be returned.

e Pending Approval - If Dual Decision Approval has been enabled, the Pending Approval hyperlink will
appear in the Dashboard. Clicking on the dollar amount hyperlink on the Pending Approval line will direct
the user to the Check Transaction Approval screen, where the user can approve or reject any transactions
that are pending approval by the user.

End of Day Cut-Off Time: Moenday PM EST

Exceptions $32,122.55 Pending Approval §

St to Pay Sat to Return £3.893.93

System System 5

JERr il - ¥

oo Q00
eocoe0o0

e Setto Pay/Setto Return - Clicking on the dollar amount hyperlinks on the Set to Pay or Set to Return lines
will expand the view to display a breakdown of the total for each category. System Pay or Return indicate
transactions that will pay or return if no action is taken due to the default status. User pay or return indicate
a Client user decision has occurred. Fl pay or return indicate a Gate City Bank decision has occurred.

For ACH Credit Review and ACH Incoming Debits: Approved List indicates the incoming ACH debits or
incoming ACH credits are from companies the client has pre-approved to debit an account or accounts.
These transactions’ status is automatically set to Approved List Pay

: . Date Range
Transaction History o
mAugust 1, 2021 - August 31, 2021 -
¥ Filters »
Trarsaction ID Accourt Murrber Serial Numibser Crrescliit Dehiit Current Status Datel: Change Status Exception
¥ 2519 w1111 12274 $127.00  Pay-System 08-31-2021 0
¥ amizE 00eE1111 2374 $27.00  Pay-System 0B-31-2021 o
» 49127 w1111 237 $35.10  Pay-System DB-31-2021 1]
» 49128 01111 2373 $20.00  Pay-System 0E-31-2021 m ;]
» 49928 w111 2274 20000 Pay-System CB-31- 024 °

e Transaction History - The user can click on the dollar amount link for any category to be directed to a
filtered view of the Transaction History. In the above example, the user has clicked on the dollar value of



Using the Dashboard

Exceptions in Check Positive Pay on the Dashboard and is directed to a view of exception transactions that
require decision.



Check Positive Pay

Creating Check Positive Pay Users

This section only applies to a Positive Pay user with the Admin user privilege.

1. From the dashboard, click Manage Users.

Dashboard | & Manage Users | JiReports ~ = Transaction View

2. The Positive Pay users page appears. Click the Create New User button.

Create New User

Please select an existing user or create a new one.
Select User

2 Controltest,
Dual

User Type

Normal w

3. The New User page appears. Fill out all fields available, click Create User button.

First Last

SSOID

First Name Last Name
First Last

Email Address Contact Phone Number Cell Phone Number
firstlast@testing.com (555) 555-5555 (555) 555-5555

e Enter the user’s Business Online Banking user ID in the SSO ID field.

4. The User profile page appears. Scroll down to the “System Roles” section of the page to select what roles
should be enabled for the user.

System Raoles

[all | none]

[ Audit Report [ Notification Delivery O consolidated
Report Transaction History View




Check Positive Pay

5. Withing the Check Positive Pay settings box, the alert method can be chosen. Use the drop-down to select
the alert method desired. See Notifications for types of Check Positive Pay notifications that will be

received.
Check Positive Pay Alert Method: |- None - v
. Email
Available Accounts Selected Accounts Email, SMS/Text
|" | | SMS/Text
I

6. Choose from the list of available accounts enrolled in Check Positive Pay the user is entitled to work with
and move them to the Selected Accounts box.

7. Assign User Privileges — See Appendix A for definitions of each privilege.

User Privileges

[all | none]
[J1tem Lookup [ Issue Item Status Report [ Transaction History
[ Change Transaction Status [J Adjusted Items Report [ Edit Issue Ttem
[]view Issue File Status [ Manage Issue File Status [ 1ssue Templates
[1ssue Load Alerts (U 1ssue Warehouse [l Load Issue File
[JManual Issue Entry [J Paid No Issue Matching

8. Select Save User.

a. Success message appears.

Manual Issue Entry

From the dashboard screen, select Change Module and go to Check Positive Pay

(® Gate City Bank

For a Better Way of Life.®

Dashboard L Manage Users  JiReports ~ i Transaction View Change Module ~

Check Positive Pay

ACH Credit Review ACH Incoming Debits
ACH Credit Review
I

1. Inthe Check Positive Pay module, select Perform > Manage Issue Entry.




Check Positive Pay

2. The Manual Issue File Entry screen appears.

(® Gate City Bank

For a Better Way of Life.”’

View -

Check Positive Pay || # Perform ~ | iReports ~

Issue File Load

Manual Issue Entry

Paid No Issue Match Welcome

Please use the above menu to select an action

Manual Issue Entry

Account’ Auto populate next check number: (]

- not selected - ¥

Row Check Number Amount Status Issuance Date

ISSUED v 07/17/2024

@ Click any row to select that row for editing

Save

Account - Select appropriate account number from the drop-down menu.

Auto populate next check number - When checked, the next check number will auto-populate in
the following row. This feature is designed to eliminate serial number entry when checks are issued
in sequential order.

When unchecked, the next check number will remain blank until it is filled in by the user.

Row - Eachissue item will be numbered in the order they are entered. Once the cursor is placed in
the current row, an additional row will appear for the next entry

Serial Number - Type the item check number for this manual issuance file in the Serial Number
field.

Amount - Type the dollar amount for this check in the Amount field.

Payee Name - Type the payee name for this check in the Payee Name field. The Payee Name field
supports the entry of a single payee, or multiple payees.

This field supports both alphabetic and numeric characters.

Please see Step #3 below for in-depth information about the Payee Name field and Multiple Payee
Names.

Status
i. Issued-The check has been issued

ii. Voided -The check has been voided by the maker.



Check Positive Pay

h. Issuance Date - Click on the Issuance Date field and select a date from the calendar that this item
was issued.

3. Payee Names - The Payee Name field supports up to four Payees.
a. Click within the Payee Name field to enter the Payee Name(s)

b. Theview size on the Payee Name field can be enlarged by dragging the bottom right corner of the
field box. The feature may not be available based upon the browser used.

c. Inputthe Payee Name in the field. If there are multiple payees, an Enter (carriage return) must be
used to input a second, third or fourth payee on separate lines in the field for it to be distinguished
as different payees.

If multiple payees are listed on a single line of the check, putting them on separate lines is not
applicable.

The Payee Name field currently supports 500 alphanumeric characters in total. This count will
include the carriage returns separating multiple payees. The 500-character limit is for the entire
field, and not per payee.

Although 500 characters are allowed in this field, names might be truncated if using a fixed
width template and the number of characters allowed in that column are less than 500.

The Payee Name field will not accept blank entries for items with issued status, and will give an
error message if an entry is attempted to be saved without a Payee Name.

4. To edit any row, click in the fields to be edited and make changes.
5. When all manualissuance files have been entered, click Save.

6. The Manual Issuance File Status detail page appears.

< Back to Status MANUAL_1721320549403

File Status

Queued Processed Approved Completed Deleted

File processing is complete. View list below to see items.

® View items: 4 Items totaling $1,100.00 Load Date: 07/18/2024 11:35 AM CDT
Rows 1 -4of 4,
Account Number Check Number Amount Status Issuance Date
XXK1342 1234 $500.00 AVAILABLE_FOR_MATCHING 07/18/2024
XXXX1342 1235 $100.00 AVAILABLE_FOR_MATCHING 07/18/2024
XXxx1342 1236 $200.00 AVAILABLE_FOR_MATCHING 07/18/2024
WHxx1342 1237 $300.00 AVAILABLE_FOR_MATCHING 07/18/2024

Delete

7. Click the Back to Status button to view the Issuance File Status page.

Important: If your company is using Dual Approval for issue files, the manual entry files must be approved
by a second client user. If no second user is available to approve the file, you can request Gate City Bank to
approve the issue file.
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Loading Issue Files

Check Positive Pay allows users to upload issue files into the system for use in matching.

1. Inthe Check Positive Pay module, select Perform and Issue File Load.

(® Gate City Bank

For a Better Way of Life.?

Check Positive Pay || # Perform ~| JiReports ~

Issue File Load

Manual Issue Entry
Paid No Issue Match Welcome

Please use the above menu to select an action

View -

2. The Load Check Issuance File page appears.

3. Select the Template drop-down box to select from a list of existing templates. Note: If only one template is
available for a client, the drop-down box selects that template by default.

4. Selectthe Account drop-down box to select the account number the checks were issued on. Note: If only
one account is available, the drop-down box selects the account by default.

5. Thefile upload interface appears. Click the Browse button to select the appropriate file.

Issue File Load

Template to Use With Issue File Account”

Standard Template v -

View Selected Template

Select one issue file that is in the format of the selected template

Browse ...

a. The Standard Template is formatted as follows:
i. File Type —Comma Separated
ii. Number of Header Rows — None
iii. Number of Footer Rows - None

iv. Multi-Line Payee Name Separator - /
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v. File Mapping:
Column 1 Column 2 Column 3 Column 4 Column 5
Check Number Amount (Fractional | Status (I for Issued Issuance Date Payee Name (if
Dollars 12.34) orV for Voided) (MM/dd/yy) enabled)

If your system supports a different file format, please contact Gate City Bank for a custom set-up.
6. Oncethefileis selected, it displays in the upload interface. Click Upload.

7. The Status Bar displays the current status of the file.

File Status

Queued Processed Approved Completed Deleted

File processing is complete. View list below to see items
® View items: 64 Items totaling $76,626.57 Load Date: 07/18/2024 11:56 AM CDT

Duplicate items will be ignored.
Rows 1 - 25 of 64.

L BE

8. If errors are encountered during the initial processing of the issuance file, the Parse Errors display appears,
allowing the user to view the error detail within the file. The most common reason this error would appear is
because the file contains improper formatting. At this point, the user will have the option to:

a. Correctthose errors.

b. Delete individual errors. This feature only displays if there are errors in the file and is only available
until errors have been corrected and the file is saved.

c. Delete all errors. This feature only displays if there are errors in the file and is only available until
errors have been corrected and the file is saved.

i. This will retain the totals and counts for audit history.

d. Discardthefile. This feature appears when there is an error in the file. This option is not available
after corrections have been made and saved.

This will remove the file and its contents from the system

If an issuance file needs to be deleted for any reason, click on the Delete button and the file will be removed.
Deleting a file will retain item counts and totals as audit history. NOTE: Files are only eligible for deletion if
every item in the file is still in an available for matching status. If just one item in the file has been paid,
the file cannot be deleted.

Multiple Payees:

Check Positive Pay can support customers with multiple payee names on issued items. The system scores
multiple names on a check against information provided in the issuance file.

a. When a user loads an issue file into the system, the loaded file is processed using the Issue Template
set up within Check Positive Pay. The Standard Issue Template allows for selection of a Multi-Line Payee
Separator by using the forward slash (/) character.

b. If multiple payees are listed on a single line of a check, no action needs to be taken.

10



Check Positive Pay

c. If multiple payees are listed on two or more separate lines on a check, the multiple payee separator
character must be used between each name. In the example below, the Multi-Line Payee Name
Separator designated in the Issue Template is a forward slash (/). The issue items shown are entered
with the pipe separator between each name, with no spaces.

Check Amount Status | Issuance Date Payee

Number

1234 12.34 | 07/18/24 First Last/Test User

1235 12.34 | 07/18/24 First Last/Test
User/Sample File

When the issue file is loaded, the system then separates the data before and after the character as
separate payees.

Issuance Dual Approval

Check Positive Pay offers the ability to support dual approval for issuance file loads, including manual issue entries
and updates to issue items within the Issue Warehouse. When enabled, manual issue entry files or issue files
loaded by the client are held in “suspended” status until approved or rejected by a secondary user.

Once thefile is loaded and pending approval, a message is sent via email or SMS within 30 seconds to client users
with the Approve Issue File user privilege to alert them of files pending approval.

1. Within the Check Positive Pay module, select View > Issue File Status.

(® Gate City Bank

For a Better Way of Life.®

Check Positive Pay  # Perform ~  JiReports ~ | & View ~

[ Issue File Status ]

Issue Warehouse
V\ Transaction History

Item Lookup

Flea 1 select an action

2. Thelssuance Files Status page appears. Files requiring dual approval will show a status of “Suspended”.
Click the Manage button to review the file.

Issuance Files Status B nar 04, 2004 -

T Filters ]

FUATE {10 File Mam Ll Load Date/Timels  Trarsactior i Transacton Total  View'Ma

y 21040 ARRCT_Eweres_Essue w ermors D3042024-001.x05 SPEMDED irI0dd 515 Al 0 W "onoge

11
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3. Thelssue File review page displays a File Status box at the top of the screen which outlines the Current
Status of the file. The status bar will highlight “Approved/Rejected,” and will note if the file is pending
approval. Approve and Reject buttons display in the File Status box.

File Status

Cainyad Processsd Appicaad | Rejected Completieo D s

4. Alist of eachissue item contained in the file displays below the File Status box. Each status displays as
“New Issuance Item.” The client user can review the entries to determine if the file should be approved or
rejected. The client user can also delete the file prior to and after approval by clicking the Delete button at
the bottom of the screen.

5. Ifthefileis to be approved, click the Approve Button. Once the file is approved, the file status displays that
the file processing is complete.

a. Afterthe approval is complete, the issue items display the status “Available for Matching.” The
Delete button will still be available to delete a file after approval.

b. Returning to the Issuance Files Status page, the file now displays a status of “Client Approved.”
6. Ifthefileisto be rejected, click the Reject Button.

a. Oncethefileisrejected, the file status displays that the file has been rejected by [client username].
The individual issue items no longer display in the issuance file status.

Exception Identification

Check Positive Pay is configured to identify exceptions on issue items in a specific order. Once the first exception is
triggered on an issue item, the system does not evaluate the item further. If an item is flagged with an exception
and is deferred to the Client user for decision, further analysis will not be performed

Listed below are the possible Exceptions and the order in which they are flagged by Check Positive Pay.

Exception | Exception Code Reason
Order
1 Account Blocked Account is Blocked
2 Issuance Not Found Check presented where no issue item is found to match against
3 Issuance Already Used Check presented with a serial number previously presented.
4 Issuance Voided Check presented with a serial number of an issue item marked with a
void status.
5 Issuance Stopped Check presented with a serial number of an issue item marked with a
stop status.
6 Issuance Amount Check presented where amount of check differs from issue amount.
Mismatch
7 Amount Over Limit Transaction amount is over the limit.

12
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8 Issuance Date in Future Check presented with a date before the issuance date on the issued
item.
9 Issuance Stale Dated Check presented with a date exceeding the specified number of stale
days for the account.
10 Issuance Payee Check presented where payee name differs from issue payee name.
Mismatch

Managing Check Presentment

Check Positive Pay provides a function to search and view the status of checks presented on enrolled accounts,
and to make decisions on presented items. Positive Pay users can use Transaction History to search for presented
check items for a specific account using the filtering options available. The default filter setting is Exceptions Only.

1. View Transaction History

Within the Check Positive Pay module, click View > Transaction History. The Transaction History page
displays all current-day transactions for all accounts to which the user has access.

Icon Exception Code Exception Reason

Check presented where no issue item is found to
match against.

Check presented with a serial number previously
presented.

Check presented with a serial number of an issue
item marked with a void status.

Check presented with a serial number of an issue
item marked with a stop status.

Check presented where amount of check differs
from issue amount.

jo

Issuance Not Found

Issuance Already Used

Issuance Voided

Issuance Stopped

Issuance Amount Mismatch

Amount Over Limit Transaction amount is over the limit.

Check presented with a date that is before the
issuance date on the issued item.

Check presented with a date that exceeds the
specified number of stale days for the account.
Check presented where payee name differs from
issue payee name.

Early Presentment

Issuance Stale Dated

> B O % 0 0 Q

Issuance Payee Mismatch

a. Tofilter the date range of items shown, click on the Date Range drop-down.

Date Range
Transaction History £ jul 25, 2024
? Filters Start Date’ End Date’ Tomorrow
07/25/2024 07/25/2024
July 2024 August 2024
Yesterday
Transaction ID Account Number Check Number Cregit 54 Me Tu We Th Fr Sa Su Mo Tu We Th Fr Sa
31 2 3 4 5 6 1 2 3 last7Days
No(
7 € 9 10 1 1212 4 5 6 7 8 % 10 This Month
14 15 16 17 18 19 20 11 12 13 14 15 16 17
° ! < > Last Month
21 22 23 24a25 27 18 19 20 21 22 23 24
Custom
28 29 30 2 25 26 27 28 290 30 2

13
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b. To narrow the search results, click Filters and a window containing additional search criteria will
appear.

Date Range
Transaction History & jul 25, 2024 ~

.

Account? Exceptions [ Default Items
Any hd Any ~ Any b
Amount Amount Range Exception Type Transaction Status
$ Any v Pay
Pay-System
Check Number Check Number Range Transaction ID Pay-FI
Pay-User
Return
s Return-System
Positive Pay Type 2
ks Return-FI
Any v Return-User
Use the "Ctrl" key to select multiple status

types above.
Apply | Reset
Rows 1 - 25 of 0.

z
Transaction ID Account Number Check Number Credit Debit Current Status Dateld Change Status Exception

c. Once search criteria are selected, click Apply to narrow your search results.

d. Searchresults are displayed in pages of 25 items. If the search contains more than 25 issue items, the

results are displayed on multiple pages. Use the navigation buttons at the top of the search results to
review all results.

2. Change Transaction Status

a. Ifthe user has been granted the Change Status user privilege and the transaction is eligible for a
decision, a Pay or Return button appears for use. If the transaction is not eligible for a decision, the
button will display as Ineligible. Reasons for the “Ineligible” message could include the item being a
deposit, the item already being decisioned, or left at the system default.

3. Change Status - Pay

a. Ifthe current status on anissued item is set to return, the user can opt to change the status to pay if
the check should be paid.

b. Click the Pay button under the Change Status column.

The Change Status button will then change to Return, and the Current Status column will update to
“Pay-User.”

4. Change Status — Return

a. Ifthe Current Status on anissued item is set to Pay, you can change the status to Return if the
check should not be paid

b. Click Return under the Change Status column.

c. Check Return Reason pop-up window appears. Select the appropriate reason for the Check Return.

d. Click Save. The system displays a success message.

14
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e. The Change Status button will then change to Pay, and the Current Status column will update to
“Return-User.”

5. Fortransactions that list the Duplicate Presentment exception reason, the user can view the duplicate and
previously presented check items to visually inspect the checks. Click on the Duplicate Presentment
hyperlink to open the Check Image window.

6. The CheckImage window opens, with the Duplicate Exception Item and Previously Presented item
displaying so the user can visually inspect both items. Click the Show Back button to view the back of the
checks.

7. The backs of the Duplicate Exception item and the Previously Presented item appear. The user can visually
inspect the images. Click the Show Front button to return to the front view of the checks. Click Close to
return to the Transaction Warehouse view.

8. Inthe expanded transaction view, both the current and previously presented check data displays for
comparison.

9. Acopy of the Transaction History can be downloaded by clicking the Download As CSV button at the
bottom of the Transaction History screen.

Review Payee

The Review Payee functionality has been introduced to allow users to visually inspect presented items to ensure
fraudulent transactions that may not have triggered any exceptions are identified.

1. If Payee Positive Pay is enabled, the Review Payee feature will be available in Transaction History. Review
Payee allows users to easily view non-exception items for transactions on accounts enrolled in Payee
Positive Pay.

2. From within Transaction History, the Payee Review button appears at the top of the screen with the total
number of non-exception items available for review in parentheses. Click the Review Payee button to

proceed.
AdE ANg
Transaction History I htr 04, 2004 =
T T —
T Filters >

Transacton IL ACCOUn? Number Serial Number Crecit  Debit Current Status Dateli Change Status Exception
& Betum

1ITEOTS ) DEVT4/203 -
¥ 1276018 xxAGAL 5180 Beturn-User O04/2024 m (=¥ 1

3. The Payee Review screen appears. The Payee Review page displays all current day non-exception
transactions for all accounts to which the user has access.

4. To narrow the review screen results, click Filters and a window containing filter criteria will appear.

5. Once search criteria are selected, click Apply to narrow your results.

15
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6. Results are displayed in pages of 25 items. If the Review Payee screen contains more than 25 items, the
results are displayed on multiple pages. Use the navigation buttons at the top of the review screen to
review all results.

7. To change the transaction status to Return, click the Return button

Trandasction [Pformatson Image

rar
. e o Wb Test Capture Only
Db Han Megommbic
erial Hurnbe (——oari | cescewd 1 ARDURT |
LT P ot 5 sl
maun 55
ssuAnCE Payes Craig Callahan Pay Craig Callahan
Ordw ik five and No cents
o - uml-imiimii
B 0] 0ERR E. bﬂb;em

NIF2RT AL T A0 ALGEDS909 T AO00000% 5007

8. Apop-up window will display to select a check return reason. Select the appropriate return reason and
click Save to proceed.

9. Oncethereturnreason is saved, the user will be returned to the Review Payee screen, and the Return
button will be displayed as an Undo button. If the user determines that the Return should be undone,
clicking the Undo button will change the status back to Pay, and the screen will revert the button to Return

Tranasction Informutio o (Chanoe Status
ran I
. . et e M s Test Capture Only
. P Berha b
i S 10
sarial Mumber: WIS T [T T T | P
% /0 7 3004 T & 1
353,36 - o
ssuanoe Payes Craig Callaksn Fay Craig Callahan
Oslwr  Fifty [ive and No cenls
" = Vold ** Vodd ** Void **
IS5 465 DR S beloere
itaeTank g 2LEAD2LEAD*R09? AD00000S 500
ar 1 T ]
A I Whtra i Test Caplure Onky
ALoounT Number e RN - .
; ’ ‘"\':L i ; Fan-Mopgniasble
&k by 1 1 CHECE B A
seAN00 TERLIT] 4 il % 1
IssuaAnDe Payes: Mary Moses e 0lAry Moscs
Ming hundred thirty three and 13 cenis
Vil F# Vioadl 2 i **
I5N: 46103505 S DelLaere
BIFPLTALL b PLEAD?LEADASOSL SO0000091735

10. Click the Back button at the top of the screen to return to the Transaction History screen.

16
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Each "
Payee Review

¥ Filters

Change Staturs

¢ ML OaKAEh e Test Capture Only

i b bashd

12. Refresh the browser window to view the changes to the Transaction History screen. The user should see the
previously changed item with the status of Return-User

Match Paid ltems

Check Positive Pay supports the ability users to match issue items loaded to the system after The end of day
process has been performed to Paid No Issue exception items.

1. From the Check Positive Pay module, click Perform > Paid No Issue Match.

Check Positive Pay = |# Perform ~| JiReports ~ = view ~

Issue File Load

Manual Issue Entry
[Paid No Issue Match] Welcome

Please use the above menu to select an action

2. The Paid No Issue Match screen displays with the current month date range by default. To filter the date
range, click on the Date Range drop-down, select the desired range, and click the Apply button.

Check Positive Pay ~ # Perform ~  aliReports ~

i
o
‘

Date Range
Paid No Issue Match

& Jun 25, 2024 -Jul 25, 2024 ~
> . .
Account’ Start Date’ End Date’ T
Any o 06/25/2024 07/25/2024

Today
June 2024 July 2024

ROW Su Mo Tu We Th Fr Sa Su Mo Tu We Th Fr Sa  Yesterday

26 27 28 29 20 31 1 nnn Last 7 Days
2345 5 7 ¢« EDEBEEBE von
v s DEGEOOE o

16 17 18 19 20 21 22 naa 26 27
23 24 a 28 290 30 A 1 2 3

| = -

Select
[all | none] Check Number Payment Date P

Select an account to searct 9 1

S
s
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3. Inthe Client portal, the Paid No Issue Match screen must be filtered by Account to display data. Type an
account name or the last 4 digits of the account number to generate the SmartSearch filter

4. Once the Account filters has been entered, the screen displays all outstanding issue items that can be
matched to Paid No Issue items previously cleared. The first line in each row presents information on the
outstanding issue item, and subsequent lines will be one or more paid no issue items that can be matched
to the outstanding item.

Diae Randge

Paid No Issue Match

[ona=t g

L]

3

B0 -
5 2§ o

-
-

5. Theuser canview check images of the paid no issue items to compare to the outstanding issue item to
determine if the items are indeed a match. Click the eye icon next to the paid amount for any paid item to
view.

6. A pop-up window with images of the front and back of the check displays. If there is more than one paid
items, examine both check images to confirm if either is a match. Click the Close button to close the check

image view.

7. Once a matchis found, click the checkbox at the left of the row to activate that row for matching. Click the
radio button of the paid no issue item that matched the outstanding issue item. Single or multiple rows can
be activated and selected for matching.

-
o | Sarial Mismbs Paymant Date abd Arnioiant Issii A soihe Dt i Ty Payes Marm

51 ]

8. Once selections are made, click the Match Selected button at the bottom of the Paid No Issue Match
screen to complete the match.
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@3

9. The Confirm Matching screen displays. Select Confirm to match any selected Issuance and Transaction
items. Click the Cancel button to cancel without matching.

10. Once Confirm is clicked, the system displays a success message.

11. The paid transaction now shows the matched issue item data in Transaction History.
Decision Dual Approval

If Decision Dual Approval is enabled and a Client User decisioned any transaction in the Transaction History to the
status of User-Pay, or adjusted the serial number or amount of any transaction, approval is requested to approve
the change of the transaction status. The secondary client user must approve the transaction decision.

1. Within the Check Positive Pay module, click Perform > Transaction Approval.

£ Manage - & Perform = Wi v =

Issue File Load

Manual Issue Entry
Welcome wp [ Tomsmsnipmon )

"ﬂ:'_'l.l'.'L' Luse I:I".' I.'I."_"'u 2 Mmenu o '.'L'I'.

Paild Mo Issue Match

2. The check transaction approval screen displays.

Check Transaction Approval

Saria Current Requestad Currant Requested

AP Dat SEatLg Statushi Excapticn

3. Clicking the arrow (>) at the far left of each row expands the view for more information about the
transaction.

4. After examining the transactions pending approval, the user can select items to approve or reject by
clicking the Approve or Deny buttons at the bottom of the screen.

5. If atransaction is Approved or Rejected, a confirmation pop-up window appears. The user can click the

Confirm or Reject button to confirm the approval or rejection of the transaction status change, or click the
Cancel button to return to the Check Transaction Approval Screen.
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6. Updating Transactions in Pending-Pay Status: In the case of No Issue transactions that are in Pending-Pay
status awaiting approval or rejection, the user may do the following:

a. Add lIssue: Atransaction currently in Pending-Pay status can be updated in the Transaction History
page by expanding the view on the transaction and clicking the Add Issue button.

Before changes, the transaction appears without payee information as shown below.

al LB gLl
_ L Aecoount Currenit Seria Aequested Serial Current Reguested Current Requested
E MM Humbe Mumbaer Amrount Amount Dite SLatus Statusds Exception
w | L] 0,

i. InTransaction History, click Add Issue.

ii. Complete the Add Issue pop-up screen by entering a Payee Name and clicking Save.

Add Issue Ttem;

Serial Mumber Amount Payee Mame’ Status Issuance Date

2B Henry Fordham [SSLEL = O304/ 2024

ccount Configured for Recon: To select a date other than today, ' out and 2dd issuance after the Pay request is approved

iii. The changes are then reflected in the Transaction Approval screen, as shown below.

Select
L ACCouUng rent Senia Fequeeshed Serial CUrrent Reqguested Curnent F!Equ-;:\'r.sr-:
e - i
mie Mismbe Mumbar Armaoung Arnousnt Diate GtafLes "_'il.nJl.U'Jl-i Exceprion
v e d AN $55.00 2024 Regem Par Q
Tra Ae e
Reaqu ! e [55 A i 45
Loa De, I R 1[5 0d
Hai ] |5 (]
Aemuested % & Py

b. Items currently in Pending-Pay status will not allow the user to adjust the seral number or amount.

Note: If a transaction decision is currently awaiting approval from a secondary user and the
transaction is not approved or rejected by end of day, the transaction will revert to its original
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status. For instance, if a transaction is set to default return and a user decisions the item to be
paid, if that decision is not approved by end of day, the item will revert to the default return
status.

21



ACH Positive Pay — Debits & Credits

Creating ACH Positive Pay Users

A client user with Admin user privileges can add additional client users, who can be authorized to use ACH Positive
Pay.

1. From Client Dashboard, click Manage Users.

(®) Gate City Bank

For a Better Way of Life.?’

Dashboard diReports ~ & Transaction View

2. Theclient users page appears. Click the Create New User button.

Dashboard 4 Manage Users ali Reports ~ £= Transaction View

Create New User
Please select an existing user or create a new one.

Select User

3. The New User page appears. Fill out all the fields available, then click Create User.

New User

SSOID

First Name Last Name

Email Address Contact Phone Number Cell Phone Number

e Enter the user’s Business Online Banking user ID in the SSO ID field.

4. The User profile page appears. Scroll down to the “System Roles” section of the page to select roles to be
enabled for the user.

System Roles

[all | none]

[J Audit Report [ Notification Delivery [ consolidated
Report Transaction History View
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5. Choose from the list of available accounts enrolled in ACH Positive Pay (ACH Credit Review and/or ACH
Incoming Debits) the user is entitled to work with and move them to the Selected Accounts box.

ACH Credit Review

Available Accounts Selected Accounts

=

ACH Incoming Debits

Available Accounts Selected Accounts

==

6. Assign User Privileges — See Appendix A for user privilege dependencies and definitions of each privilege.

User Privileges

[all | none]
[ Act on Approved List [J Act on Blocked List (] Approved List
([ Blocked List [ Change Transaction Status [ Notification Rules
[ Notification Rules Report [ Decision Dual Approval ] Approved List Dual Approval
[ Blocked List Dual Approval [ Transaction History

7. Click Save User.
a. A success message appears.

b. Once the use profile has been built, the user can subscribe to ACH Incoming Debit and/or ACH
Credit review Notifications.
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Transaction History

There are two ways to navigate to the Transaction History page. Click on one of the hyperlinks from your dashboard
or click on Transaction View from the menu.

(® Gate City Bank

For a Better Way of Life.®

Dashboard & Manage Users  diReports ~

ACH Credit Review

End of Day Cut-Off Time: Wednesday 12:00 PM CDT

Total ACH Credits $0.00 (0] Pending Approval $0.00

Set to Pay $0.00 0 Set to Return $0.00

@00

Approved List Exceptions $0.00 (o] Block List Returns $0.00

1. The transaction history page displays all current day transactions for all accounts to which the user has
access.

2. The Violation column displays icons to inform the user of ACH Positive Pay exception(s).

Icon Exception Code Exception Reason
Q Not Found Company ID not found on Approved or Blocked List
c Frequency Approved list violation —frequency
Violation
B Duplicate Approved list violation — duplicate in file
b Block List Originating Depository Financial Institution mismatch
Mismatch
$ Amount Mismatch | Transaction amount does not match
L ] Amount Over Limit | Transaction amount is over the limit
SEC Code SEC Codes on transactions do not match
Mismatch
o Date Range Transaction is out of date range
@ Block List Violation | Accountis blocked

Change Transaction Status

1. Ifthe user has been granted the Change Status user privilege and the transaction is eligible for a decision, a
Pay or Return button appears for use. If the transaction is ineligible for a decision, the button will display as
Ineligible.

2. Change Status - Pay

a. Ifthe Current Status on anissued item is set to Return, the user can opt to change the status to Pay
if the debit transaction should be paid.

b. Click the Pay button under the Manage column
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Date Company Acoount # Armount Current Status LA anage Violation

»  05/02/2024 OLIVIA'S OMELETT xoomdddd 5430000  Approved List Pay
KXE -
» 05/02/2024 NIVEEMA'S NATURA nooaddd $60.00  Approved List Pay
> 05/02/2024 MARSHALL MODELIN 004444 $1.042.00  Pay - System =

c. Asuccess message will appear temporarily in the Manage column, with an option to Add to
Approved List. This link appears if the user has the Act on Approved List user privilege. The user can
click the hyperlink embedded in that option to proceed to Add to Approved list. If the user does not
opt to Add to Approved list, the option is still available under the expanded view of this debit item.

 05/02/2024 OLIVIA'S OMELETT woddad $500.00  Return - User

Date Company ACcount ¥ Amount Current Status Manage Violation
» OLIVIA'S OMELETT o444 $4,300.00  Approved List Pay
% 05/02/2024 OLIVIA'S OMELETT o044 $800.00 Pay - User Debit will be pald.
+ Addt Approved List
% 05/02/2024 NIVEENA'S MATURA 00444 $50.00  Approved List Pay
% 050272024 MARSHALL MODELTN o044 $1.042.00  Pay - System & Retim =

d. After a few moments, the Change Status button will then change to Return, and the Current Status
column will update to “Pay-User.”

3. Change Status — Return

a. Ifthe Current Status on an issued item is set to Pay, the user can change the status to Return if the
debit transaction should be returned.

b. Clickthe Return button under the Manage column.

Date Company Account # Amount Lurrent Status Manage Violation
> 050272024 OLIVIAS OMELETT oooedd44 §4.300.00 Approved List Pay & Return —

»  05/02/2024 OLIVIA'S OMELETT 000444 SE00.00  Pay - User
¥ 05/02/2024 MIVEENA'S NATURA wocd444 s60.00  Approved List Pay
»  05/02/2024 MARSHALL MODELIN o444 $1.04200  Pay-System -

c. Asuccess message appears temporarily in the Manage column, with an option to Add to Block List.
This link appears if the user has the Act on Block List user privilege. The user can click the hyperlink
embedded in that option to proceed to Add to Block list. If the user does not opt to Add to Block
List, the option is still available under the expanded view of this debit item.

It is important to note that if a Written Statement of Unauthorized Debit is required, the Add to
Block List hyperlink will not appear, as the Written Statement of Unauthorized Debit will pop-up
instead. In this case, the user must expand the view of the debit item to Add to the Block List.

A required Written Statement of Unauthorized Debit can be completed to return a PPD (Prearranged
Payment and Deposit Entry) transaction. A Written Statement of Unauthorized Debit pop-up screen
will appear. The user will be prompted to select a reason for the return of the transaction by clicking
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on one of the radio buttons by the appropriate return reason. Once the reason has been selected,
click Next to continue. Clicking Cancel will cancel the process and the user will be returned to the
Transaction History screen.

Written Statement of Unauthorized Debit

To return this transaction you are required to complete a Written Statement of Unauthorized Debit.

This transaction is a PPD ACH debit for $800.50 to Client 3 from your account xxai 111

A PPD (Prearranged Payment and Deposit Entry) is a one-time or recurring debit used to transfer funds from a consumer account.
Please select the reason you are returning this transaction:

Never Authorized to Debit Account
Authorized ACH Debit Amount Incorrect
Debited Before Date Authorized

Debit Authorization was Revoked

3rd Party Did Mot Send Funds to Payee

Improperly reinitiated l

e — =

d. Depending on the return reason selected, the user may have an additional screen to provide more
information about the return reason, such as correcting the ACH Amount or selecting the date the
debit was authorized, etc. Once this screen has been completed, click Next to continue. Clicking
Cancel will cancel the process and the user will be returned to the Transaction History screen.

e. Thefinal screen within the pop-up window is the Written Statement. The content of the Written
Statement displays based on the valid return options for the disputed transaction. The Written
Statement must be completed for the transaction to be returned. If the Written Statement is
abandoned, the transaction status will remain unchanged.

f. The user must consent to the Written Statement of Unauthorized Debit by electronically signing the
form. The user must click the checkbox next to the statement “I consent to electronically signing
this form.” Once the user has done so, the “e-signature needed” button will change to a Sign button.
In addition, a PDF copy of the Written Statement downloads by default. The user can opt not to
download by unchecking the Download PDF Copy option. Once the screen is correct, click Sign to
proceed with the return process.

g. Asuccess message appears, and a copy of the Written Statement downloads to the user’s PC,
unless the user opted out.

h. The Change Status button will then change to Pay, and the Current Status column will update to
“Return-User.”

Decision Dual Approval

ACH Positive Pay offers the ability to support dual approval for client decisioning. If Decision Dual Approval is
enabled, and a Client User has decisioned any transaction in the Transaction History to the status of Pay, the
transaction will be listed as Pending-Pay and an alert message will be sent via email and/or SMS text message
requesting the approval of the change of the transaction status. The secondary client user must approve the
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transaction decision. Reminder alerts will be sent out to client users even if a client user has logged into the
system that day. This is to ensure that pending items are addressed before the end of day cut-off time.

1. Within the ACH Incoming Debits/ACH Credit Review module, select Perform and Transaction Approval.

(®) Gate City Bank

For a Better Way of Life.?

ACH Incoming Debits £ Manage ~ i Reports - iE Transaction Histary

[ Transaction Approval ]

Approved List Approval

Blocked List Approval Ie

Please use the above menu to select an action

2. Thetransaction approval screen will display

Debit Transaction Approval

Date Company Account®  Amount Current Status Requested Statusli

> 05/02/2024 MARSHALL MODELIN xKx 2222 $1,042.00  Return - System Pary

> 05022024 KELSEY'S KHAFTS Return - System Pay

Clicking the arrow (>) at the far left of each row will expand the view for more pertinent information about
the transaction.

3. After examining the transactions pending approval, the user can select items to approve or deny by clicking
on the Approve or Deny buttons at the bottom of the screen.

4. After the transaction is approved or denied, a confirmation pop-up window appears. The user can click the
confirm button or click the cancel button return to the previous approval screen.

Approved List

The Approved List allows clients to identify companies allowed to debit or credit an account or accounts and set
parameters to control the debit/credit activity. Users can populate the approved list either through the Manage >
Approved List menu option, or from Transaction History. Companies added from Transaction History will only be
added to the account associated with the transaction it was added on. To allow the company to debit or credit
other accounts, the user must edit the approved list. Users can edit and delete companies from their approved list.

1. Within the ACH Incoming Debits/ACH Credit review module, click Manage > Approved List.
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ACH Incoming Debits | |®# Manage ~| . Perform ~ iliReports ~  i& Transaction History

Motification Rules

Block List Welcome

Please use the above menu to select an action

2. The Approved List page displays.

3. To create an entry for the Approved List, click the +Create button.

Approved List
Company ID ¢ Company Name &
Delete Max Amount Frequency Start Date End Date Edit
O Edit
@ Delete Selected @ Cancel

4. The Add Company page will display. Complete all applicable fields in the top section of the screen.

Approved Company

Company Detail

Company ID Company Name
Max Amount Frequency No Frequency o
Start Date 07/24/2024 End Date

Add Accounts to Approved List

-

~ Save @ Cancel
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Field Name | Optional or | Field Validated Field Content Notes
Required
Company ID | Required Exact Match Max: 10 A-Z
a-z
#
0-9
, (comma)
- (dash)
(space)
_(underscore)
Company Optional Not Validated Max: 16 A-Z
Name a-z
#
0-9
, (comma)
- (dash)
(space)
_(underscore)
Max Amount | Optional e Thetransaction meetsthe |e Blank: Any amount | Valid
parameters when the is accepted and Characters:
amount is less than or equal will not trigger an 0-9
to the Max Amount alert.
e Thetransaction does not e Zero: Will not be
meet the parameters when accepted and
the amount is greater than entry will not save
the Max Amount. to Approved List
e Highest amount:
$99,999,999.99
Frequency Optional e If multiple transactionsare |e No Frequency: Any | Counter: The

on afile, the sort order is
highest to lowest dollar
value.

o [fthe transaction with the
highest dollar value exceeds
the Maximum Amount, all
transactions on thefile are
not approved.

e Ifthe transaction with the
highest dollar value is equal
to or less than the Maximum
Amount, that transaction is
approved and all other
transactions on thefile are
not approved.

frequency is
accepted and will
not trigger an alert.

e Daily: 1 business
day

o Weekly: 7 calendar
days

o Bi-Weekly: 14
calendar days

e Monthly: Monthly
date-to-date

e Quarterly:
Quarterly date-to-
date

e Yearly: Yearly date-
to-date

counter
begins with
the first
transaction
received after
the Company
and Account
is added to the
Approved List
regardless if
the
transaction
meets or does
not meet the
parameters of
the Approved
List.
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Date-to-Date
Exceptions:

e Non-Leap Year
January 29, 30, 31:
February 28

e Leap YearJanuary
30, 31, February 29

e March 31: April 30

e May31:June 30

e August 31:
September 30

e October 31:
November 30

parameters when the field is
blank.

Start Date Required The transaction meets the The Start Date is Valid
parameters when the date is | based on the Characters:
equal to or after the Start settlement date. 0-9
Date.
The transaction does not
meet the parameters when
the date is before the Start
Date.

End Date Optional The transaction meets the The End Date is based | Valid
parameters when the date is | on the settlement Characters:
equal to or before the End date. 0-9
Date. Approved List
The transaction does not Expiry
meet the parameters when Notification:
the date is after the End When End
Date. Date set nears
The transaction meets the expiration,

notifications
will be sent to
client users
with the Act
on Approved
List user
privilege, to
allow users to
extend the
end date of
the entry.

5. If no optional parameters are configured for an approved list entry, the system will only validate against the

Company ID.

6. Choose from the list of available accounts to add to the Approved List.

> and <move individual accounts between list of available accounts and selected accounts.
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>> and << move all accounts between the available and selected accounts fields.
7. Once the entry is completed, click Save to save it to the approved list. A success message will appear.

8. To edit any entity on the Approved List, click the Edit hyperlink at the end of the appropriate row to be taken
to the Company’s screen

9. To delete any entity on the Approved list, click the checkbox next to the appropriate row, and click the
Delete Selected button.

Add to Approved List from Transaction History

1. From the transaction history page, click the > arrow to expand the entry of the ACH transaction.

Date Company Account # Amount Current Status Manage Violation

w  01/29/2024 OLIVIA'S OMELETT on0edddA 54300.00  Approved List Pay

Juattro Formaggi oomdd44 SEC Code: BTE Ad e e Bllock L

2. Clickthe Add to Approved List button to add a company. The Add Company pop-up window will appear.
3. Click Save to add to the approved list. Click Cancel to return to the transaction history without adding to
the approved list.

4. The user will be directed to the Transaction History page once the company has been added to the
approved list.

Perform Approved List Dual Approval

ACH Positive Pay provides the ability to support dual approval for changes, additions, or deletions to Approved
Lists. If Dual Approval for Approved List is enabled and a client user has created or edited any entry to the
Approved List, the proposed addition or change is held in pending status. A secondary client user or an Fl user
must approve the change or addition to the Approved List. Reminder alerts regarding the outstanding Dual
Approval request will be sent to secondary client users regularly until the entry is approved or rejected.

1. From the ACH Incoming Debits/ACH Credit Review menu, select Perform > Approved List Approval.

ACH Incoming Debits £ Manage ~ diReports - iE Transaction History

Transaction Approval

[ Approved List Appravel}
Blocked List Approval Ie

Please use the above menu to select an action

2. The Approved List Request Approval screen displays, along with whether the entry is newly created, or an
edit or deletion of an existing entry. Each entry row automatically displays in expanded view to show all
pertinent information changed, added, or removed.
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Approved List Approval

Rows 1-1of 1.
~ [ Company ID: Created Requested by:

Requested Company Details Existing Accounts Added
Company Name
Maximum Amount
Frequency
06/28/2024 Start Date
End Date

3. After examining the Approved List entries pending approval, the user can select items to approve or deny by
clicking the checkbox for each entry and clicking the Approve or Deny buttons at the bottom of the screen.

4. If anentryis Approved or Denied, a confirmation pop-up window appears. The user can click the Confirm
button to confirm the approval or denial of the Approved List entry or click the Cancel button to return to
the Approved List Request Approval screen.

Blocked List

The Blocked List allows Clients to identify companies NOT allowed to debit an account or accounts. Populating the
blocked list can be done through either the Manage > Blocked List menu option or adding companies to the
blocked list from Transaction History. Companies added from Transaction History will only be added to the
account associated with the transaction it was added on. To prevent the company from debiting other accounts,
the user must edit the blocked list. Users can edit and delete companies from their blocked list.

1. Within the ACH Incoming Debits/ACH Credit review module, click Manage > Blocked List.
2. The Blocked List page displays.

3. To create an entry for the Blocked List, click the + Create button.

+ Create
Block List

CompanyID ¢ Company Name ¢
Delete Start Date End Date Edit

O 06/28/2024 Edit

a 06/28/2024 Edit

@ Delete Selected @ Cancel

4. The Blocked Company page displays. Complete all applicable fields in the top section of the screen.

Field Name | Optional or | Field Validated Field Content Notes
Required
Company ID | Required Exact Match Max: 10 A-Z
a-z
#
0-9
, (comma)
- (dash)
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parameters when the field is
blank.

(space)
_(underscore)
Company Optional Not Validated Max: 16 A-Z
Name a-z
#
0-9
, (comma)
- (dash)
(space)
_(underscore)
Start Date Required e Thetransaction meetsthe | The Start Date is Valid
parameters when the date is | based on the Characters:
equal to or after the Start settlement date. 0-9
Date.
e The transaction does not
meet the parameters when
the date is before the Start
Date.
End Date Optional e Thetransaction meetsthe | The End Date is based | Valid
parameters when the date is | on the settlement Characters:
equal to or before the End date. 0-9
Date. Approved List
e Thetransaction does not Expiry
meet the parameters when Notification:
the date is after the End When End
Date. Date set nears
e The transaction meets the expiration,

notifications
will be sent to
client users
with the Act
on Approved
List user
privilege, to
allow users to
extend the
end date of
the entry.

5. Choose from the list of available accounts to add to the Approved List.

7.

> and <move individual accounts between list of available accounts and selected accounts.

>> and << move all accounts between the available and selected accounts fields.

Once the entry is completed, click Save to save it to the Blocked List. The new entry will appear on the

Block List.

To edit any entity on the Block List, click the Edit hyperlink at the end of the appropriate row to be taken to
the Company’s screen.
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8. To delete any entity on the Block list, click the checkbox next to the appropriate row, and click the Delete
Selected button.

Add to Blocked List from Transaction History
1. From the Transaction History, click the > arrow to expand the entry of the ACH transaction.
2. Clickthe Add to Blocked List to add a company. The Add Company pop-up window will appear.

3. Click the Save button to add to Block List. Click Cancel to return to the Transaction History without adding
to the Block List.

4. The useris directed to the Transaction History page once the company has been added to the Block List.

Perform Blocked List Dual Approval

ACH Positive Pay provides the ability to support dual approval for changes, additions or deletions to Blocked Lists.
If Dual Approval for Blocked List is enabled and a client user has created or edited any entry to the Blocked List, the
proposed addition or change is held in pending status. A secondary client user must approve the change or
addition to the Blocked List. Reminder alerts regarding the outstanding Dual Approval request will be sent to
secondary client users regularly until the entry is approved or rejected.

1. From the ACH Incoming Debits/ACH Credit Review menu, select Perform > Block List Approval.

ACH Incoming Debits  #¥Manage ~ [[.# Perform ~| JiReports ~  iE Transaction History

Transaction Approval
Approved List Approval
[Blackecl List Approvell Ie

Please use the above menu to select an action

2. The Blocked List Request Approval screen will display, along with whether the entry is newly created, or an
edit or deletion of an existing entry. Each entry row automatically displays in expanded view to show all
pertinent information changed, added, or removed.

3. After examining the Blocked List entries pending approval, the user can select items to approve or deny by
clicking the checkbox for each entry and clicking the Approve or Deny buttons at the bottom of the screen.

4. If anentryis Approved or Denied, a confirmation pop-up window appears. The user can click the Confirm
button to confirm the approval or denial of the Blocked List entry or click the Cancel button to return to the
Blocked List Request Approval screen.
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Preferences

Preferences allows users to bypass the system default landing page and automatically place the user within the
service module and page to perform routine functions. For instance, a user may want to automatically land in the
Transaction History page when entering the system, instead of going to the Dashboard and clicking on Change
Module and then Transaction History.

1. From within the Dashboard or a module, click your name on the top left side of your screen and then select
Preferences.

(® Gate City Bank

For a Better Way of Life.®

Dashboard & Manage Users  JiReports v i Transaction View

/ACH Credit Review
O Logout
End of Day Cut-Off Time: Wednesday 12:00 PM CDT

2. The Preferences page appears.

Preferences

Default Pages

Default Module

Dashboard v

Default Check Positive Pay Page

- default - v
Default Dashboard Page

- default - hd
Default ACH Incoming Debits Page

Reports / Approved List v

Default ACH Credit Review Page

Manage / Approved List v

a. Choose your preferred default pages for each module and click Save.
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Notification Rules

Notification rules establish who should be alerted, how they should be alerted, and the conditions prompting an
alert. Notification rules can be set on an account-by-account basis, or all accounts can be configured with the
same notification rules. The two notification options are email and SMS text.

One of three levels of notifications can be established for exception alerts. The notification level options and
descriptions are provided in the table below.

Notification Level Description

Transaction Alerts One alert sent for each exception identified.

Account Alerts One alert sent per account when one or more exceptions are identified.

Service Alerts One alert sent per user when one or more exceptions are identified on one
or more enrolled accounts.

Check Positive Pay Alerts

These notifications are set up at the user level.

Alert Type Description

Exception Alert Occurs when a check is presented for payment that does not match the
issue information provided.

Issuance File Load Alert Occurs when an issue file is loaded. The alert contains status information
to indicate if the issue file loaded properly or failed to load due to errors.

Issue File Pending Approval Occurs when the issue file is loaded and the file is being held in
“Suspended” status until approved by a secondary user.

Decision Approval Required Occurs when check transaction decisions require a secondary approval.

ACH Incoming Debits and/or ACH Credit Review

Setup Notification Method and Condition

1. From the ACH Incoming Debits or ACH Credit Review module, click Manage and Notification Rules.

(® Gate City Bank

For a Better Way of Life.®

ACH Incoming Debits £ Manage ~ | # Perform ~ JMiReports ~ = Transaction History

Approved List
Block it Welcome

Please use the above menu ta select an action

2. The Manage Notification Rules page appears. The selection screen is the first screen of the Notification
Rules page and displays a list of all accounts the user has access to.
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Notification Rules

m Contacts Conditions = Confirm

Account Selection

Select Account(s) Account(s) Selected

*Accounts with default Notification Rules

Next =

Select the accounts to be configured and move them to the Selected Accounts box. It is important to note
multiple accounts can be selected to make changes and updates if they currently share the exact same
contact information and Notification Condition configuration.

Once all accounts have been selected, click Next.

3. The Contacts screen is the second screen of the Notification Rules page. The Contact screen will allow
entry of up to 6 email addresses and up to 6 cell phone numbers.

Selection Conditions Confirm

Enter the contact information to receive the ALERT

Cell Phane Text

Cell Phone 1 Cell Phane 4
Cell Phone 2 Cell Phane 5
Cell Phone 3 Cell Phone 6
Emails

Email 1 Email 4
Email 2 Email 5
Email 3 Email 6

Use Default Contact and Conditions

+ Back Next =

Add cell phone numbers and/or email addresses for users that should be notified of ACH Positive Pay
exceptions.

Once all phone numbers and email addresses have been entered, click Next.

4. The Conditions screen is the third screen of the Notification Rules page. On this page, the user can define
the criteria for when alerts should be sent. The alert criteria controls the alerting process but does not
control the transaction status designated at load time. The transaction status is controlled by the default
setting, approved and block list settings. Only one radio button can be selected.
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Notification Rules

Selection Contacts Ee il Confirm

e  Notify for all ACH Debits

Select a condition to receive the Alert

Notify only when an ACH Debit is over
Notify only when an ACH Debit meets one or more of the following criteria
The ACH Debit was created from a payment made by check
The ACH Debit was created from a payment over the Internet
The ACH Debit was created from a payment over the phone
Motify only when an ACH Debit is received from a Company 1D not on the Approved List or does not meet the parameters on the Approved List

+ Back

Alerts Received

An alert will be sent for every ACH debit/credit received on the

accounts configured with this notification condition.

e Enterthe dollar amount.

e Alerts are only sent when an ACH Debit/Credit is received
greater than the dollar amount entered.

e Alerts are not sent when an ACH Debit/Credit is received equal
to or less than the dollar amount established.

Notify only when an ACH e Select one, two or all three criteria:

Debit/Credit meets one or more of e Payment was made by check and converted to an ACH entry

the following criteria (includes transactions with an ARC, BOC, POP, or RCK

standard entry class code).

e Payment from a bank account was authorized by a consumer
over the internet or on a mobile phone (includes
transactions with a WEB standard entry class code).

e Payment from a bank account was authorized by a consumer
over the telephone (includes transactions a TEL standard
entry class code).

e Analertis sent only when an ACH debit is received on the
account from a Company ID not set up on the approved list or is

Condition
Notify for all ACH Debits/Credits

Notify only when an ACH
Debit/Credit is over

Notify only when an ACH Debit is
received from a Company ID that

5.

is not on the Approved List or does
not meet the parameters on the
Approved List

set up on the approved list but violates one of the additional
parameters set, such as maximum amount, frequency, or start
or end date. Alerts will NOT be sent on ACH debit transactions
received from Company IDs set up on the approved list and are
within approved list parameters. Those transactions will receive
a status of approved list pay. However, the status can be
changed from within Transaction History.

Click Next.

The Confirm Notification Rules page summarizes your choices. Review all information entered and, if
correct, click Save. If changes are needed, click the Back button to navigate back to the appropriate

screen.

6. After Saveis clicked, a success message appears.
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Appendix A

ACH Debit & Credit Review Permissions

Permission

Description

Act on Approved List

User has the privilege to add a company to the
approved list from the Transaction History screen or
from Setup > Approved List. When a company is added
to the approved list from Transaction History the
system will only assign the account for the associated
transaction

Act on Blocked List

User has the privilege to add a company to the blocked
list from the Transaction History screen or from Setup
> Block List. When a company is added to the blocked
list from Transaction History, the system will only
assign the account for the associated transaction.

Approved List

User has the privilege to view Approved List entries.

Approved List Dual Control

User has the privilege to approve or reject entries,
edits, or deletions to the Approved List.

Blocked List

User has the privilege to view Blocked List entries.

Blocked List Dual Approval

User has the privilege to approve or reject entries,
edits, or deletions to the Blocked List.

Change Transaction Status

User has the privilege to view transactions and to
change the status of transactions. User must also have
the Transaction History User Privilege.

Decision Dual Approval

Allows the user to approve transactions awaiting an
Approve or Deny decision.

Notification Rules

User has the privilege to configure the notification
conditions for accounts.

Notification Rules Report

User has the privilege to view Notification Rules for
accounts

Transaction History

User has the privilege to view transactions.

ACH Positive Pay User Privilege Dependencies

Privilege

Feature Dependencies

Act on Approved List

Transaction History

Act on Blocked List

Transaction History

Approved List

Approved List Dual Approval

Dual Approval — Approved List

Blocked List

Blocked List Dual Approval

Dual Approval — Blocked List

Change Transaction Status

Transaction History

Decision Dual Approval

Decision Dual Approval

Notification Rules

Notification Rules Report

Transaction History
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Appendix A

Check Positive Pay Permissions

Permission Description

Adjusted Items Report User can view items adjusted during the cleanup
process or during client decisioning.

Change Transaction Status Requires Transaction History user privilege. Allows

user to change the status of a transaction from return
to pay or pay to return.

Edit Issue ltem Allows a user to modify issue items.

Issue Item Status Report Allows the user to view issued items by status for a
specific date or date range.

Issue Load Alerts Will receive success or failure alerts when issue files
are loaded.

Issue Templates Allows a user to create a template defining the format

of the issue file they will load, including the format and
location for the data elements to be provided in the
file. If this privilege is enabled, the user can manage
additional issue fields.

Issue Warehouse Allows the user to view issued items and history.

Item Lookup Ability to look up all recorded data on individual issued
items.

Load Issue File Allows the user to load issue files via the client portal

Manage Issue File Status Ability to edit parse errors in the file or delete issue
files.

Manual Issue Entry Allows the user to manually create an issue item.

Paid No Issue Matching Ability to match issue items loaded to the system after

cleanup has been performed to Pay No Issue
exception items.

Transaction History Allows the user to view check transactions presented
for payment. If this privilege is enabled, the user will
also have access to an item lookup sub-menu option.
View Issue File Status Allows the user to view the status of issue files loaded
into the system.
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